Discoverer Plus
FMS Training
This session was designed to be instructor led and follows traditional classroom activities you may have been previously exposed to. In this course, the instructor will present information about how to use the Discoverer Plus Report Creation Tool. You will be asked to complete activities/exercises in this manual. Following along in the manual will help you complete this course successfully.

*Please avoid using your computer until the instructor has asked you to do so.*

<table>
<thead>
<tr>
<th>Session Manual Key</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Discussion:</strong> Look, listen, interact, and learn! These pages will focus on concepts, highlight certain topics/items, or even ask for your feedback.</td>
</tr>
<tr>
<td><strong>Procedure:</strong> Look, listen. That's basically it. Watch the demonstration and follow along in your manual.</td>
</tr>
<tr>
<td><strong>On Your Own Activity:</strong> The instructor talked about it. You've seen it. Now perform the task following the steps provided.</td>
</tr>
<tr>
<td><strong>Exercise:</strong> Test your knowledge and skills! Complete the exercise per the instructions. If you need help... <em>just ask!</em> We want you to succeed.</td>
</tr>
</tbody>
</table>
Defining Course Prerequisites

The following are recommended course prerequisites:

- Experience using the World Wide Web
- Experience with Database Functionality
- Experience with WSU Report Writing Concepts
- Banner System Overview
- Applicable Banner System Modules
- Discoverer Viewer Training Module
## Discoverer Plus FMS Training - Session Agenda

### Lesson 1: Discoverer Plus Navigation
- **Topic 1:** Overview & Object Access Architecture
- **Topic 2:** Defining Student Views, Uses & Origins
- **Topic 3:** Key Concepts and Terminology
- **Topic 4:** Data Access Security

### Lesson 2: Creating a New Workbook
- **Topic 1:** Accessing Discoverer Plus
- **Topic 2:** Creating a Student Workbook - *Workbook Wizard* steps 1-4
  1. Initial layout option selection
  2. Select view and desired data elements
  3. Column arrangement
  4. Column heading formatting
- **Topic 3:** Adding Conditions (step 5)
- **Topic 4:** Inserting Parameters (step 10)
- **Topic 5:** Discoverer Plus Menu and Tool Bars
- **Topic 6:** Two ways to Open an Existing Workbook
  1. When launching Discoverer Plus
  2. From inside Discoverer Plus
- **Topic 7:** Saving a Student Workbook / E-Report

### Lesson 3: Workbook Editing
- **Topic 1:** Accessing Editing Functions
- **Topic 2:** Editing & Deleting Conditions
- **Topic 3:** Advanced Workbook Attributes (*Workbook Wizard* steps 6-9)
  1. Establishing Data Sort Preferences (*Wizard* step 6)
  2. Adding Calculations (*Wizard* step 7)
  3. Inserting Percentages (*Wizard* step 8)
  4. Assigning totals (*Wizard* step 9)
- **Topic 4:** Advanced Workbook Data Management
  1. Pivoting Workbook Data
  2. Drilling Into and Out of Data
  3. Duplicating Tables

### Lesson 4: Sharing Created Workbook E-Report Contents
- **Topic 1:** Printing Worksheets
- **Topic 2:** Exporting Data to other Applications
- **Topic 3:** Sharing Workbook / E-Report Contents

### Appendix: Discoverer Plus Application Options & Settings
Lesson 1: An Introduction to Discoverer Plus
Lesson Agenda

Topic 1: Overview & Object Access Architecture
Topic 2: Defining FMS Views, Uses & Origins
Topic 3: Key Concepts and Terminology
Topic 4: Data Access Security
Your ultimate goal in using Discoverer Plus is to analyze your business processes and make properly informed decisions.

With Discoverer Plus, you take full control of the reporting process, getting information when you need it, and the information specific to your individual needs.

After you select the data you want, Discoverer Plus presents it to you in a familiar spreadsheet-like format. Discoverer provides you with powerful tools that help you analyze this data.
In addition to sorting, you can also arrange your data to create comparisons. You can drill into data to see deeper levels of detail or related information that is also stored in the database. You can create totals, calculate percentages, and even create custom calculations on your data. And whenever necessary, you can create graphs from your data.

Your end result is a collection of worksheets / E-Reports and graphs that persuasively supports your individual business processes.
The **WSU Data Mart** databases contain data that supports your business decisions. However, getting data from a large database can be difficult.

*Discoverer* is designed to help you get data simply by dragging and dropping items in a user-friendly environment. You do not need to understand how to program in the SQL.

The Data Access Team (DAT) in C&IT has organized the data in your database into business areas. A *business area*, Alumni, FMS, Student and FMS, contains information that pertains to a specific area of University administration. With business areas, you see only the data that interests you, and you do not have to search through the entire data population found in the Banner system.
Each of the Data Mart systems contain a wealth of information stored within numerous database tables.

*Banner Object Access* is a technical architecture designed to make it easier for you to find the information you need, allowing you to create ad hoc reports easily and quickly.

The Object Access architecture uses logically grouped *views* to bring together the related data elements for a specific area of reporting.

The *Data Dictionary* workbook/E-Report is a primary reference source to views and their contents.
A view, or logical view, is a grouping of information. They are called “logical” views because the information in the view is grouped in a logical order, putting related information in the same section of the view.

For instance, in the Object Access, people-related views you will find all of the name information together at the beginning of the view, followed by personal, biographical, and demographic information.

Most of the information in a view comes from fields within the Banner database tables. Some information is calculated from database fields or otherwise retrieved using an administrative Oracle function.

Trivia: A view can include up to 255 pieces of information, called attributes.
**Worksheets / E-Reports:** Worksheets contain the desired data and allow you to analyze and share the compiled information with others. Each E-Report is created by its own query. Every time you open a workbook, *Discoverer Plus* queries the *Data Mart* database to get the most current data.

**Workbooks:** A workbook is a collection of E-Reports Worksheets. A *workbook* contains individual worksheets of data that are related but organized to show different aspects and perspectives.

**Note**

The terms *E-Report*, *workbook* and *worksheet* are used interchangeably throughout this manual. The use of the term is subject to the tool you are currently using and your own preference. From the *Discoverer Viewer* users’ perspective, the workbooks/worksheets created in *Discoverer Plus* are the *E-Reports* they run in *Viewer*.
**Queries:** A *query* is a *search* that *Discoverer Plus* runs against the database in order to retrieve the data you want. Every time you open a worksheet or create a new one, Discoverer performs a search (query) of the applicable WSU Data Mart.

**Items:** This is another term for *data elements*, or *data fields* that make up the E-Report / worksheet.

**Page Items:** This special item groups a worksheet’s data into separate “pages”. By selecting different Page Items in the Page Item drop-down list, you are actually switching pages within that worksheet.
After you retrieve and analyze your data, you may want to share your results or worksheets with other people.

Worksheets can be shared with others who can then use either Discoverer Plus, or Discoverer Viewer/E-Reports to access the data directly from the Data Mart.

An alternative method of sharing information is achieved by exporting retrieved worksheet data which can then be accessed with applications such as Excel and Access.

NOTE
Access to WSU data is always determined by the individual’s security setting / role within Banner and the Data Mart. Subsequently, when you share an E-Report which compiles specific types of information, those who access this report will see only that which complies with their security profile.

Contact security@wayne.edu or the Data Access Team (dat@lists.wayne.edu) with any questions.
In this lesson, you learned about:

Topic 1: Overview & Object Access Architecture
Topic 2: Defining FMS Views, Uses & Origins
Topic 3: Key Concepts and Terminology
This Page Intentionally Left Blank
Lesson 2: Getting Started With Discoverer Plus
Lesson Agenda

Topic 1: Accessing Discoverer Plus

Topic 2: Creating an FMS Workbook - Workbook Wizard steps 1-4
   1. Initial layout option selection
   2. Select view and desired data elements
   3. Column arrangement
   4. Column heading formatting

Topic 3: Adding Conditions (step 5)

Topic 4: Inserting Parameters (step 10)

Topic 5: Discoverer Plus Menu and Tool Bars

Topic 6: 2 ways to Open an Existing Workbook
   1. When launching Discoverer Plus
   2. From inside Discoverer Plus

Topic 7: Saving an FMS Workbook / E-Report
Discoverer Plus is most easily accessed via **Campus Pipeline**. Follow this path:

Pipeline =>
     School Services =>
      Administrative Services=>
       Discoverer Plus

Once at the Discoverer Plus web page...

Click the **Click to Start** icon.
Connect to Discoverer Plus

4. The Connect to Discoverer dialog appears
5. Type your Banner Username
6. Type your Banner Password
7. Type the Database - DMPROD
8. Click Connect

For this training session, sign into Plus using the following:
Username: trainXX
Password: trainXX
Database: dmtrng6
xx = 2 digit number from 01 to 30
### Activity Objectives

1. Accessing *Discoverer Plus*
2. Initiating the *Workbook Wizard*

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launch Internet Explorer =&gt; Log into <a href="http://pipeline.wayne.edu">pipeline.wayne.edu</a></td>
<td>Use your own WSU Access ID and email password to access WSU Pipeline</td>
</tr>
<tr>
<td>Follow this sequence: School Services =&gt; Administrative Services =&gt; [click on] <em>Discoverer Plus</em></td>
<td>Each step represents an appropriately labeled hyperlink in the WSU Pipeline environment</td>
</tr>
<tr>
<td>Log into <em>Discoverer Plus</em> using: Username: <code>trainXX</code> Password: <code>trainXX</code> Database: <code>dmtrng6</code> <code>xx</code> = 2 digit number from 01 to 30</td>
<td>Type the appropriate information in the fields.</td>
</tr>
<tr>
<td>Click <em>Connect</em> or or press the <em>Enter</em> key</td>
<td>The <em>Workbook Wizard</em> menu will appear.</td>
</tr>
</tbody>
</table>
Creating an FMS Workbook

Steps:
1. In the workbook wizard, click create a new workbook.
2. Click the Table radio button.
3. Click Next.
Creating a Workbook / Worksheet Steps Continued:

4. Select the appropriate Business Area to access the desired view.

5. Select the items from that View to be included in your Workbook. To select multiple fields, hold down control key and while clicking on individual items.
Workbook Wizard Step 2 of 10:

Creating a Workbook / Worksheet Steps Continued:

6. Click the **Right Arrow** button to add the fields to the report.
7. Click the **Left Arrow** to remove the field.
8. Click **Next**
Workbook Wizard Step 3 of 10:
In this step you can arrange the sequence of columns and page items.

Creating a Workbook / Worksheet Steps Continued:

9. Click and Drag columns to where you want them placed in the report. The heavy black line indicates where the column being dragged will be positioned as you click & drag across the page.

10. When finished, click Next

Note: when a column heading is highlighted, the delete key will delete the column and data item from your worksheet.
Workbook Wizard Step 4 of 10:

In this step you can change the heading names and heading formatting.

Creating a Workbook / Worksheet Steps Continued:
11. Select the heading you want to change.
12. Click Edit Heading to change the name.
13. Click Format Heading to change the font, size, color and more.
14. Click Format Data to determine how data will be formatted within this workbook.
Workbook Wizard Step 4 of 10 (cont):

Creating a Workbook / Worksheet Steps Continued:

Selecting to either **Format** or **Edit** a heading or **Format Data** will call up the appropriate dialog box.

**Format Data**: Changes the look of the data in the columns.

**Format Heading**: Changes the look of the column heading/name.

Make the desired changes in the appropriate dialog box. Click **OK** when finished.

Once back at the Workbook Wizard window, click **next** to continue to Workbook Wizard step 5.
**Activity Objectives:**
- Creating a Student workbook
- Adding Fields to the Workbook to be Created
- Arrange Fields / Column Layout
- Edit Heading text & Formatting

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Create a new workbook</td>
<td>Click on File</td>
</tr>
<tr>
<td>2) Select the Business Area &amp; data fields you want to include in your workbook</td>
<td>Click each item that you wish to add to the workbook that you are creating. Hold down shift &amp; click each choice to select multiple fields.</td>
</tr>
<tr>
<td>3) Once you have finished adding the desired fields, click the Next button</td>
<td>The Workbook Wizard advances forward to Table Layout - step 3 of 10</td>
</tr>
<tr>
<td>4) Select the column names to be rearranged - when finished, click the Next button</td>
<td>Click &amp; drag columns to the desired sequence. Click</td>
</tr>
<tr>
<td>5) Edit heading text, heading and data format options</td>
<td>Make desired changes to the heading names, and formatting</td>
</tr>
</tbody>
</table>
Workbook Wizard Step 5 of 10:

Create a Condition:
1. Click the New button.

Note
Conditions filter data based on a condition.

Ex. Year > 1999
Create a Condition:
2. Type a name for this condition, or allow Plus to create one for you.
3. Enter a description for this condition.

Note: This window can be stretched out wider to make working in it much easier.
Creating a Condition Continued
5. Click the **Item** drop-down arrow and choose the appropriate field.
6. Click the **Condition** drop-down arrow. Choose the condition you wish to add.
7. Click the **Value** drop down arrow and select a value to enter.
8. Click OK when finished.
Workbook Wizard steps 6 through 9 allow you to sort data, create calculations, and create totals. Information on the use of these topics will be covered later in today’s training session.

After step 4 of the Wizard, you may want to click Finish which will allow you to view the report and the resulting query information. Once you’re satisfied with the initial report construction, you can create new calculations, parameters, etc., using the edit worksheet menu.

For purposes of this training session, we will be skipping steps 6 through 9 by clicking the next button to advance to Workbook Wizard step 10.

Note: The steps being bypassed will be covered in Lesson 3.
Databases often contain enormous amounts of information, and one key task necessary to work with a database efficiently is to find the specific information you want to see or analyze. There are 2 ways to filter (analyze) data within workbooks: apply Conditions and select Parameters. So far, we have discussed Conditions.

**Parameters**: provides choices for filtering data. An example of this would be to look at an individuals from a particular state. You could either examine separate parameters independently, or choose to examine both at once.

**Benefits of parameters**

You can chose the specific data to see on the worksheet.

Worksheets open more quickly because the amount of data on a worksheet is limited by the choices offered by the parameters.

Each person using the worksheet, can open the worksheet and get just the data of interest to themselves.
Workbook Wizard Step 10 of 10:

To Create a Parameter:

1. Click **New** button.
Workbook Wizard Step 10 of 10:

2. **What do you want to name this parameter** – the name you want to appear in the Parameters field.

3. **Which item would you like to base your parameter on** – From the pull down list, select the data field upon which this parameter is to be based upon.
4. What prompt do you want to show other users? – enter the text which prompts the user to enter criteria upon which the worksheet will retrieve matching data.

5. What description do you want to show to other users – Enter a description to explain the parameter to other users.
6. What is the value of this parameter if it is used in more than one sheet? – allows for this parameter’s value(s) to apply to all worksheets within a workbook, or to a specific worksheet only.

7. Parameterized Conditions – instructs Discoverer Plus whether or not to create a corresponding condition to support this parameter.

8. Click OK to finish the creation of this parameter. The Workbook Wizard window reappears.

Create additional parameters or click Finish button to finalize the creation of the workbook.
To Save a Workbook:
On the **File** menu, click **Save**

**Saving a worksheet with a different name:**
On the **File** menu, click **Save As**

**Closing a workbook:**
Click **File**, and click **Close**. You will be prompted to save any changes you have made to the worksheet, if applicable.

**Renaming a Worksheet Steps:**
1. Click the **Sheet** menu, select **Rename Sheet**
2. Enter the new name for the worksheet.
3. Click **OK**
Discoverer provides you with a standard menu bar and tool bar.

The menu bar includes selections for common tasks such as printing, saving files, and getting Help.

Most features and functions of Discoverer Plus are accessible from the menu bar. Each menu selection provides you with a dialog or Wizard to help you perform a task.
The tool bar provides 1-click access to many of the most popular functions and features of Discoverer Plus.
To Open an Existing Workbook:

1. Click Open toolbar button
   - or -
   Select ‘Open’ item from the File menu
2. Click the Database button in the resulting pop-up dialog.

Lesson 2: Getting Started With Discoverer Plus
Topic 7: Opening an Existing Workbook
Open an Existing Workbook (cont)

A list of available workbooks now appears on the screen.

Steps:
3. Select the desired workbook.
4. Click Open.
Note
The following steps show how to open a workbook using the Workbook Wizard you encounter when first starting Discoverer Plus.

Opening a Different Workbook:
1. Click button alongside ‘Open an existing workbook’ option
2. Click ‘Database’ button

From this point, the file open process is identical to that which has previously been documented.
In this lesson, you learned about:

- Accessing Discoverer Plus (topic 1)
- Creating an FMS Workbook - Workbook Wizard steps 1-4 (topic 2)
  - 1. Initial layout option selection
  - 2. Select view and desired data elements
  - 3. Column arrangement
  - 4. Column heading formatting
- Adding Conditions (step 5) (topic 3)
- Inserting Parameters (step 10) (topic 4)
- Discoverer Plus Menu and Tool Bars (topic 5)
- 2 ways to Open an Existing Workbook
  - 1. When launching Discoverer Plus
  - 2. From inside Discoverer Plus
- Saving an FMS Workbook (topic 7)
Lesson 3: Editing a Previously Created Workbook
In this lesson, we’ll take a closer look at editing an existing workbook, along with reviewing the advanced workbook attributes presented in Workbook Wizard steps 6-9.

Topic 1: Accessing Editing Functions
Topic 2: Editing & Deleting Conditions
Topic 3: Advanced Workbook Attributes (Workbook Wizard steps 6-9)
   1. Establishing Data Sort Preferences (Wizard step 6)
   2. Adding Calculations (Wizard step 7)
   3. Inserting Percentages (Wizard step 8)
   4. Assigning totals (Wizard step 9)
Topic 4: Advanced Workbook Data Management
   1. Pivoting Workbook Data
   2. Drilling Into and Out of Data
   3. Duplicating Tables
Existing workbooks can be modified at any time. Accessing the specific workbook attribute to be edited can be done in a variety of methods:

1. Toolbar
2. Sheet on the menubar
3. Tools on the menubar
Lesson 3: Workbook Editing
Topic 2: Editing Conditions

Editor a Worksheet:
From the Sheet Menu, choose "Edit Sheet."

The tabs across the top of the "Edit Worksheet" dialog box provide easy access to the various worksheet attributes.

Note: notice how these folder tabs are in the same sequence as the Workbook Wizard steps 2-10.
Editing & Deleting Conditions:

Because information is constantly updated and changed, from time to time you may need to edit your conditions to reflect the change.

Since you can turn conditions on & off, deleting is not used very often.

Once you delete a condition, it is permanently removed from the workbook.
View Available Conditions:

1. From the **Tools** menu, Click **Condition**.
View Available Conditions:

2. Click the View Conditions for drop down arrow to select category of conditions to work with.
3. Select the condition you wish to edit from the displayed list.

Select one of the following:

Field – Lists conditions that apply only to the selected data item.

All Items – Conditions defined for all items in worksheet.

Active Only – Lists only the conditions turned on for the current worksheet.
Turn Conditions On & Off:

4. To turn condition off: click the subject condition’s check box (check mark disappears.)

5. To turn condition on: click the subject condition’s check box (check mark appears.)

6. Click OK when finished editing.

Note:
Clicking delete permanently removes the condition from the workbook.
The following pages review advanced workbook attributes - the functions that are covered in *Workbook Wizard* steps 6 through 9.

1. Data Sort Preferences (Wizard step 6)
2. Adding Calculations (Wizard step 7)
3. Inserting Percentages (Wizard step 8)
4. Assigning totals (Wizard step 9)
Topic 3: Establishing Data Sort Settings

Sorting arranges data into either alphabetical or numerical order. Also helpful for analyzing data. An example, would be wanting to look at budgets from the highest to lowest.

**Sorting Data Steps:**

Click the *Add* button

Note: Data sort settings can also be established at Step 6 of the Workbook Wizard.
Sorting Data Steps:

2. Choose the data element you want to base the sort order on.
Sorting Data Steps:

3. Click the Directions arrow and select the desired sort order.
Sorting Data Steps:

3. Click the *Directions* arrow and select the sort order.

Choosing *grouping* option:

4. Click on pull-down menu for group options - click on choice.

5. Click *Add* button for additional levels of data sorting.

Notes:

- Grouped items are automatically first in order sequence -
- Column names of grouped items are italicized.
Workbook Wizard Step 7 of 10:

Calculations play an important part when analyzing data. Discoverer Plus has a full range of common mathematical functions and operators to calculate results on your worksheets. It displays the results of calculations as new columns on a worksheet, or it can be part of other calculations.

Adding Calculations:
1. In the Edit Sheet window, click on the Calculations foldertab, click New.
Workbook Wizard Step 7 of 10:

Adding Calculations Continued:

2. Type a name for the calculation.

3. Click the Show drop-down list

4. Click each data element you want to add to the calculation and click the paste button.
Workbook Wizard Step 7 of 10:

Adding Calculations Continued:

5. Click the **operator** buttons to add mathematical operations.

6. Add other **Selected Items** to the Calculation window until the desired equation is achieved.

7. Click **OK** to complete creation of the new calculation and return to the *Edit Worksheet* window.
Adding Calculations Steps:

Continue until all desired calculations are created.
Observe each calculation has a check mark next to it, allowing for temporary deactivation of calculation later on.
8) Click Ok when finished to re-run the worksheet incorporating the new calculation(s).

Note: each new calculation will have a corresponding column added to the worksheet. At this point, you might want to return to the Table Layout foldertab to adjust this column placement.
### Activity Objectives:
- Adding Calculations to a Workbook

<table>
<thead>
<tr>
<th>Steps:</th>
<th>Action:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Click the New button to begin creating the desired calculation.</td>
<td>The New Calculation dialog appears.</td>
</tr>
<tr>
<td>2) Type a name for the calculation in the box at the top of the dialog.</td>
<td>This name appears on the worksheet as the column header of the calculation results column.</td>
</tr>
<tr>
<td>3) Click the <strong>Show</strong> drop-down list to see the different expressions.</td>
<td>The item or function moves to the Calculation text box. You can also drag from the box on the left to the Calculation text box.</td>
</tr>
<tr>
<td>4) Click the operator (for example, + or -) button to add mathematical operations to the Calculation text box.</td>
<td>Continue to add items, functions, operators until you complete your calculation expression.</td>
</tr>
<tr>
<td>5) Click <strong>OK</strong> to save the expression.</td>
<td>The Edit Worksheet dialog appears and displays the name of the calculation you just created.</td>
</tr>
</tbody>
</table>
Workbook Wizard Step 8 of 10:

Using the Percentages feature, you specify the data to use to calculate a percentage as well as the value to use to represent the percentage (Grand Total, Subtotal, and so on).

Inserting Percentages Steps:
1. On the Edit Sheet Percentage foldertab, click New.
Workbook Wizard Step 8 of 10:

Inserting Percentages Steps:
2. Click in the name field and enter a name for this percentage definition.
3. Click the drop-down list to see the list of data items available to use to calculate percentages.
4. Select the data items.
Workbook Wizard Step 8 of 10:

Inserting Percentages Steps:

5. Select one of the options to calculate a percentage.

6. Select to display the percentages for all page items, or only for the current page items.

7. On the right side of the dialog, select whether to display the total amount as well as the percentage.

8. Enter labels for the percentages, or click the drop-down lists for labels and choose additional formatting options.
Workbook Wizard Step 8 of 10:

Inserting Percentages Steps:

9. Click OK to return to the Percentages dialog in the Edit Sheet window with the new definition.
10. Click OK to display the new percentage in the worksheet.
Workbook Wizard Step 9 of 10:

When working with numeric information, you often need to see various summations of the data.

Totals can sum rows and columns of numbers, find averages and standard deviation, compute subtotals and grand totals, and so on.

Discoverer Plus automatically adds a column or row to the worksheet for the totals data.

Inserting Totals:
1. On the Edit Worksheet Totals tab page, click New.
Workbook Wizard Step 9 of 10:

Inserting Totals:

2. Click the *data point* drop-down list and select the data point to use for totaling data. You can also create totals for all the data points on the worksheet by selecting All Data Points from the drop-down list.

3. Click the drop-down list for the type of total you want to use for totaling data.
Workbook Wizard Step 9 of 10:

Inserting Totals Steps:

4. Click one of the options for the current page or all pages.

5. Click the checkbox to generate the label automatically. Uncheck to create & format your own label or name for this total.

6. Click OK when finished assigning the Total.
These techniques are of great value in sophisticated analysis of your data.

- Pivoting Workbook Data
- Drilling Into and Out of Data
- Duplicating Tables
Pivoting organizes your data by moving items from the main body of a table worksheet to the page axis.

**Pivoting Steps:**

1. Choose the Sheet menu, click *Table Layout*.
2. Select the column to pivot.
3. Drag the column to its new location.
4. Click OK.

This example shows how to pivot the *Full_Name* column to the Page Axis.
Drilling helps you easily locate related information in a worksheet. For example, suppose you’re analyzing data showing activity at a quarterly level. To see the data at a higher level, such as yearly, you can drill out of the information. Similarly, if you want to analyze data at a monthly level, you can drill into that level.

- Drilling out of data consolidates the data for a broader overview
- Drilling into data shows more details about the data

So, drill into data to analyze it at a finer level of detail, and drill out to get the larger picture.

Discoverer Plus provides drill icons to quickly and easily drill up or down in a table or crosstab. You can use drill icons to drill through data in several ways.
**Drilling Steps:**

Click the drill icon in the column or row with the data you want to drill. From the drop-down menu, choose the level of data you want to drill (up or down).

---

**Collapsing Drilled Items:**

Click the drill icon. Select a value above the current value.

---

**Note:** Data on a worksheet is often organized in the hierarchical sequence. Typically, you would drill, for example, from Region to City.
Duplicating tables and crosstabs provides a quick, easy way to present still more perspectives on the data. You might, for example, want to duplicate an existing table so that you can use the analytical properties offered by pivoting on a crosstab layout or vice versa.

**Duplicating Steps:**

1. Click the Sheet menu  Duplicate a Table or Sheet  Duplicate as Crosstab
2. Indicate which items you want to display in the new table or crosstab
3. Arrange the columns & page items the way you want
4. Click OK
Lesson Review : Editing a Previously Created Workbook

In this lesson, you learned about:

Accessing Editing Functions (Topic 1)
Editing & Deleting Conditions (Topic 2)
Advanced Workbook Attributes (Workbook Wizard steps 6-9) (Topic 3)
  1. Data Sort Preferences (Wizard step 6)
  2. Adding Calculations (Wizard step 7)
  3. Inserting Percentages (Wizard step 8)
  4. Assigning totals (Wizard step 9)
Advanced Workbook Data Management (Topic 4)
  1. Pivoting Workbook Data
  2. Drilling Into and Out of Data
  3. Duplicating Tables
This Page Intentionally Left Blank
Lesson 4: Sharing Workbook / E-Report Contents
Lesson Agenda

Topic 1: Printing Worksheets
Topic 2: Exporting Data to other Applications
Topic 3: Sharing Workbook / E-Report Contents
Discoverer Plus provides a Print Wizard to help you print your worksheets. You can expect what you see on the screen, to print out the same way on paper including worksheet titles and page items.

**Printing:**
1. Click the *File* menu.
2. Click *Print*.

**Note:** To print the data results that are currently being displayed, click the *print* button on the *toolbar*. This approach by-passes the *Print Wizard*. 
Printing Worksheets:

3. Select either Current Worksheet or All worksheets using the radio button as shown.

4. Select which type or style of worksheet you want to print.

5. Click Next.

Note: The Print Wizard process causes Discoverer to rerun the query prior to printing.
You will now be at the Edit Parameter Values page. This allows you the option of restricting your printout to certain items.

**Printing Worksheets Continued:**

6. Enter desired parameters, if applicable.
7. Click Next.
Printing Continued:

8. Select whether or not you want to **supervise** the printing process (see below for detailed explanation of these options.)

9. Click **Finish**.

In the resulting **Print** dialog box, make your print option selections and click **OK**.

**Supervised** - If you want to see the alert messages while printing.

**Unsupervised** - If you want to ignore any alert messages while printing.

**Skip long running queries** - Click this checkbox if you expect that some of the worksheets will take a long time to print and you don’t want to wait.
Discoverer Plus’ Export Wizard is an aid to help you share your worksheets’ data with other people by exporting it to popular application formats.

Exporting a worksheet sends its data; but depending on the type of format you choose, the exported worksheet may also include the formatting and layout. However, it does not export Plus features such as calculations and conditions.

You can export a single worksheet or all worksheets. One file will be created for each worksheet.
To export worksheet data:
1. Click on the *File* menu,
2. Click *Export*. 
Exporting Continued:
3. Select which worksheet(s) you wish to export.
4. If you have both table & crosstabs, select desired export option.
5. Click Next.
Exporting Continued:

6. Select an **export format** from the drop-down list.

   It is recommended to choose the **CSV (Comma delimited)** format.
Exporting Continued:

7. Type the path, or browse to the folder location where you want to have the resulting export file(s) saved.
8. Click Next.
Exporting Continued:

9. Enter desired parameters, if applicable.
10. Click Next.
Exporting Continued:

11. Select whether or not you want to supervise the export process (see below for detailed explanation of these options.)

12. Click Finish.

**Supervised** - If you want to see the alert messages while printing.

**Unsupervised** - If you want to ignore any alert messages while printing.

**Skip long running queries** - Click this checkbox if you expect that some of the worksheets will take a long time to print and you don’t want to wait.
Exporting Continued:

When complete, the “Export Log” box appears. This reports the status of the export process.

13. Click OK On the Export Log.
Lesson 4: Sharing Workbook / E-Report Contents
Topic 2: Exporting Data to Other Applications

Exporting to Excel and HTML formats is quite simple in *Plus*.

*Plus* provides toolbar buttons to help you quickly export worksheets to these specific formats.

**Open** - Choosing this option opens the worksheet from the database as a Microsoft Excel Spreadsheet or HTML Page.

**Save** - This option will save the worksheet on your local hard drive as an Excel Spreadsheet or HTML Page.

Export to HTML Steps:
- From the *File* menu, click *Export to HTML* - or click the toolbar *Export to HTML* icon
- Click either *Open* or *Save*
- Click *OK*

Export to Excel Steps:
- From the *File* menu, click *Export to Excel* - or - click the toolbar *Export to Excel* icon
- Click either *Open* or *Save*
- Click *OK*
Sharing a workbook / E-Report allows other people to view, analyze, and print the workbook. You can share workbooks with other people two ways:

- Share one workbook with multiple Plus / Viewer users
- Share multiple workbooks with one Plus / Viewer user

Sharing workbooks lets others use and analyze the same data. For example, you might want everyone in the finance department to share a workbook that includes accounts payable and accounts receivable information.
Sharing a Workbook:

1. Click on the *File* menu.
2. Click *Manage Workbooks*.
3. Click *Sharing*.

![Diagram illustrating the steps to share a workbook.]
Sharing a Single Workbook to Several Users:

1. In the Dialog Box, click the Workbook – User tab.
2. Click the Workbook pull down list
3. In the list of available workbooks, click the name of the workbook to be shared.
Topic 3: Sharing Workbook / E-Report Content

Sharing a Single Workbook to Several Users:

4. In the Available Users list, choose the name of the person(s) or group(s) to which you are sharing.

Tip: hold the control or shift key to make multiple selections.

5. Click the right arrow to add those names to the list of users who have access to that report.

6. Click OK.
Sharing Several Workbooks to Other Users:

1. In the **Share Workbook** dialog box, click the **User – Workbook** tab.

2. Click to display the **User** pull down list.

3. Click on the name of the person or group to whom you want to share your workbooks with.
Sharing Several Workbooks to a Single User:

4. In the list of Available Workbooks, **Click** the name of the workbook to share.

5. **Click** the right arrow to Add each workbook to be shared.

6. **Click** OK.

Repeat for all workbooks you are sharing.
In this lesson, you learned how to:

- Topic 1: Print a Worksheet
- Topic 2: Export Data to other Applications
- Topic 3: Share Workbook / E-Report Contents
Appendix: Discoverer Plus Options Settings
Discoverer Plus provides opportunity to set program preferences and options. Access to the application options is on the tools menu (see side illustration).

In the resulting Options dialog,折叠tabs across the top list the different option categories:
- General
- Query Governor
- Sheet Format
- Default Formats
- Advanced
- EUL

The following pages will provide details on each of these categories.
To set **General** options:

1. Select the defaults for opening a workbook and running a query to load the data.
2. Run query automatically--Discoverer automatically retrieves the data specified by the worksheet in the workbook. Select this option to retrieve data for the worksheet as soon as you open a workbook or click on the tab of a worksheet.
3. Don't run query (leave sheet empty)--Opens the workbook and worksheet, but does not retrieve any data from the database. That is, the worksheet opens but does not contain any data. A typical reason for selecting this option is to see a different worksheet than the one that opens by default without waiting for the query results.
4. Ask for confirmation--This is the default selection. After the workbook opens, a dialog asks if you want to run the query for the first worksheet.
5. Show wizard graphics--Several Discoverer dialogs include artistic graphics (bitmaps). Deselect this option if you don't want to see the graphics in the dialogs.
Setting Query Governor Options

The Query Governor options help reduce the amount of time it takes to display data. You can set defaults for Summary Data and for Queries.

**CAUTION:** Do not change *Summary Table* options without assistance from the Discoverer Administrator.

The *Query Governor* options help you set limits on the amount of time a query should take to complete. The options set time and size limits on data as it is being retrieved from the datamart.

Note: Your Discoverer Administrator determines the upper limits for the Query Governor options. For example, your Discoverer Administrator may determine that queries cannot run longer than 30 minutes. If you set the limit for 60 minutes, the numbers will change back to 30 automatically.
To set Query Governor options:

Warn me if predicted query time exceeds--When requesting data for a worksheet, Discoverer estimates the time required to complete the query. Select this option if you want a message to warn that the query will take a long time to complete. The message appears only if the estimated completion time exceeds the period you specify, in MM:SS format, for this option.

Prevent queries from running longer than--Select this option to limit the time a query runs before it is cancelled. A warning message informs you if the query exceeds the set time, then Discoverer cancels the query. Normally, this option is selected if server performance is an issue because long running queries might affect server performance.

Limit retrieved query data to--This option sets the maximum number of rows to retrieve for a query. If the query returns more rows than the value you set here, a message informs you that not all data is retrieved and, consequently, the displayed data might not be complete.
Appendix: Discoverer Plus Option Settings

To set Query Governor options - continued:

Retrieves data incrementally in groups of—Set this option when the database contains large tables with many rows that might take a long time to retrieve. With this option selected, Discoverer retrieves rows of data in increments rather than all at the same time. The smaller the number of rows to retrieve as a group, the faster the initial retrieval. The default size of the data group is 250 rows, which equates to the first 10 pages of data at 25 rows per page. You can set the number of rows per page using the Rows per Page option on the Sheet Format tab.

Cancel list-of-values retrieval after—Some dialogs have a convenient drop-down list from which you can select a value for an option instead of manually typing the value. This is called a list of values. For example, when creating a condition for analyzing monthly sales data, you could either choose the value, July, from a list of months, or manually type the name "July" as part of the condition statement. But some large lists of values take a long time to retrieve from the database, such as a list of 20,000 part numbers. If you don't want to wait for Discoverer to retrieve these larger lists of values, click the up and down arrows to set the maximum amount of time you would wait for this list to appear. This option does not cancel Discoverer's retrieval of the actual data for a query. In the case of the part numbers, for example, all the data about the parts in stock, price per part, sales figures and so on, is displayed in the appropriate tables. Only the drop-down list of part numbers in various dialogs would not be available.
Setting Sheet Format Options
This tab in the Options dialog is for setting the display format of the table or crosstab.

Title--Displays a title if one was created earlier.

Horizontal and Vertical Gridlines--Lines that separate rows and columns. The display example on the dialog shows a representation of your choices.

Null values as--A cell that contains a null value does not contain any data. Select the text to use to designate a null value from the drop-down list or type a value in the box.

CAUTION: If you select the 0 (zero) symbol as the null value, it may appear to the person looking at the table or crosstab that zero is the actual data. For example, in a cell specifying amount owed, zero means nothing is owed, whereas a null value in the same cell might mean that no information is available about the amount owed. Therefore, using the zero symbol to indicate null values might be misleading to others.
Setting Sheet Format Options - Continued

Values that cannot be aggregated as--Numbers that cannot be aggregated are formatted one of the values in the pull down list.

**Row Numbers** (Table only)--Sequential numbers of each row in the table, shown on the left side of the table.

**Inline/Outline** (Crosstabs only)--Arrangement of the side axis data items. As you select one of the options the example icon represents the arrangement.

**Rows per screen page**--The number of data rows on each page of the worksheet. Click the up and down arrow buttons to select the number.
Setting Default Format Options

The Default Format options are for setting the font style, text color and background color of a worksheet's data, column headings, and totals.

To see a default format, select it in the list. The Example box shows a preview of the format settings.

To change a default format, select from the list of formats.

Click the Change button. The Data Format dialog appears where the following attributes can be adjusted:

- **Size**—Choose a size for the font from the drop-down list.
- **Style**—Click a button to display the text in a boldface, italic, underline, or strikethrough. Click the appropriate button to remove the style if it is already in effect.
- **Color**—Click the button to apply a color to either the text or the background. A palette of colors appears. Click the one you want.
- **Alignment**—Click an alignment option. The options display the data in the top, middle or bottom of the appropriate cell on the table or crosstab.
- **Actual font size**—Select this option to display the data in the sample in the font size that you choose from the size drop-down list.
Setting Advanced Options
The Advanced options are for turning on/off automatic querying and for catching join errors that relate to database relationships.

Automatic Querying--When you make a change to a worksheet that affects the data results (as opposed to formatting changes), Discoverer automatically re-queries the database to display the appropriate results based on your changes. However, you can use this option to disable the automatic query feature in case you want to make changes to the worksheet but not have Discoverer update the data. See "About Automatic Querying" for more details.

CAUTION: Do not change these options without assistance from the Discoverer Administrator.
In this training session today, the following concepts and procedures were demonstrated:

- Defined Banner Object Access Architecture
- Analyzed FMS View Uses and Origins
- Viewing Scheduled Workbooks
- Editing a Worksheet
- Deleting a Workbook
- Sharing Workbooks to Viewer Users
- Pivoting Data
- Duplicating Tables
- Calculating Percentages
- Define FMS Data Views
- Opening an Existing Workbook
- Creating a New Workbook
- Saving a Workbook
- Printing Worksheets
- Sorting Data
- Drilling Into and Out of Data
- Adding Calculations to a Worksheet
- Exporting Data to Other Applications

Practicing your skills will increase your level of efficiency! While these concepts are still fresh in your memory, be sure to practice as soon as possible back at your computer.

Thank you for your time and attention!